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What is Genetics Construction Kit? 

Genetics Construction Kit (GCK) is a simulation of a classical genetics 
laboratory.  It provides you with a set of organisms with unknown patterns of 
inheritance, and gives you the tools to design and perform an experimental 
strategy to discover these inheritance patterns.  You will be able to cross the 
unknown organisms and analyze your crosses in ways much like those used by 
practicing scientists.  GCK is not meant to replace  work with real organisms.  
But the constraints of time, space, money, and unskilled laboratory technique -- 
important parts of real scientific research -- make it practically impossible for 
most students to experience the excitement and challenge of a real research 
problem.  GCK can give you the chance to work with problems that have the real 
surprise and real complexity that make scientific research a fascinating activity.  
We have tried in this program to let you tackle realistic problems in a way 
similar to that used in real scientific research.  You or your instructor however, 
can set up GCK so you can start with a limited set of genetic phenomena and 
add new material as your understanding grows. 
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A Tour of Genetics Construction Kit 

Starting the Program  

To start the program, double click  on the GCK program icon (see Figure 1).   

 
Figure 1.  The GCK Program Icon 
 
The next thing you see will probably be a list of problems such as that shown in 
figure 2.  The names of the problems will probably be different.  If you don't see 
a list of problems, your copy of GCK only contains a single problem. It has 
started that problem, and you can skip the next section on how to choose a 
problem.  If you do not see a display similar to that in Figure 2 or Figure 3, 
something is not working.  Try looking at the end of this manual in It Doesn't 
Work! for some suggestions. 
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Choosing a Problem 

 
Figure 2. Selecting a GCK Problem1 
 
To choose a problem, click on it to highlight it in black (like 1 Trait, Simple 
Dominance in Figure 2), then click on Start Problem.     
 
 
If you click on the button labeled Quit instead of Start Problem, GCK will stop 
running. 
 

                                                 
1If you don’t see a picture of a fruit fly but have a set of buttons displayed instead,  you have a 
customizable copy of the program that allows you to create your own problems.  For the moment, 
ignore this difference and continue with the tutorial.  The section of the manual entitled Designing 
Your Own Problems discusses how to customize the program. 
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Looking at the Field Population 

 
 
  Figure 3. The initial display of a GCK problem 
 
A GCK  problem always starts like this (Figure 3), with a vial of organisms of 
unknown genetic constitution.  The initial vial is labeled Field Population to 
remind you that these organisms may be considered to have been collected at 
random.  They are not the result of a mating between two parents. 
 
 Your problem will not look exactly like this.  This particular vial contains a 
number of organisms that differ in one trait, the thorax.  Your problem may 
involve more than one trait, a different trait, or different variations. 
 
Grooveless and tetralterra are the names of two thorax variations in real fruit 
flies.  For our purposes right now, it does not matter what a tetralterra thorax 
actually looks like2.  Bear in mind, however, that although the names used here 
may be the names of the traits of a real organism, the way they are inherited will 
almost certainly be different.  The genetics of the organisms used by GCK vary 
from problem to problem. 
 
On the left there is a set of male and female symbols.  Remember that  is the 
standard symbol for a male and  is the standard female symbol.  Each of these 
symbols represents a unique individual with its own, distinct genotype. 
 
The first two rows of organisms in Figure 3 have a grooveless thorax and the 
second two rows have a tetralterra thorax.  The arrow is shown over a male with 

                                                 
2If you are curious you might want to consult a drosophila manual.  Most commercial suppliers of 
fruit flies have these. 
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a grooveless thorax.  If you click on a trait variation name, a dotted line will be 
drawn around the organisms with that variation.  Figure 4 is an example of this. 
 
 
 

 
Figure 4. The dotted line shows that the first two rows of organisms are Grooveless 

Doing a Cross 

 
Figure 5. The GCK Cross menu 

 

Get Some Help 
 
In Figure 5 the Cross menu has been pulled down.  You can see that the cross 
menu itself and all of the menu items are gray.  A menu is gray if all of its items 
are gray, and a menu item is gray if it won't do anything.   A gray menu or menu 
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item is usually called inactive.  While the entire cross menu may not be gray in 
your problem, some of the individual items on the cross menu will be gray. 
 
In GCK, if you try to choose an inactive menu item, you will be shown a short 
message explaining why the item is inactive and how to make it active. 
 
To try this, pull-down the Cross menu and try to choose the Cross Two  menu 
item. 
 
When you release the button, a window like that in Figure 6 will appear.  To see 
the remaining text, move the mouse pointer over the downward pointing arrow 
and click.  To dismiss the help message, click in the window’s close box. 

 
Figure 6. A message explaining why Cross Two is gray. 
 
This message tells us that we need to select two organisms of opposite sexes 
before we can do a Cross Two  cross .  
 

Select the Organisms to Cross 
 
To select  the two organisms you want to cross, move the mouse pointer over an 
organism, and click.  That organism will be selected.  A selected organism is 
highlighted in black.  In Figure 7, the third organism in the first row (a male) is 
selected.  To select a second organism, you need to hold down the shift  key on 
your keyboard while you click on the second organism.  
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Figure 7.  Selecting an organism 
 
 

Choose Cross Two 
 
After you have chosen and selected two individuals, pull-down the Cross menu 
and choose Cross Two.  If you have selected two individuals of the same sex,  or 
if you don't have two individuals selected, Cross Two  will be gray to indicate 
that it is not possible.  In this case, select two organisms of the opposite sex and 
try again. 
 

Look at the Progeny 
 
When you have crossed two individuals, a vial of progeny will be produced.  
This vial will be assigned the next number in the sequence of vials and placed in 
the next space on the screen. The sex and phenotype of the parents of each vial 
are recorded in a space at the bottom of every vial (note that vial 1 has no 
parents).  Figure 8 shows vial 1 and vial 2.   As you can see, the phenotypes of 
vial 2's parents are recorded at the bottom.  The number preceding each parent is 
the number of the vial the parent came from.  In this case both parents came from 
vial 1.   
 
The two sex symbols that you see highlighted in Figure 8 represent the same 
individual, once in its home vial and once as a parent in vial 2.  Clicking on 
either one will highlight them both.  If the same organism is a parent in more 
than one vial it will be highlighted everywhere it appears.  This is a convenient 
way to tell exactly which individuals have been used in which crosses. 
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Figure 8. The results of the cross. The female parent of vial 2 has been selected. 
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Look at All the Progeny 

If you click in a vial’s zoom box, in the upper righthand corner, the vial will 
expand so as to display all of the organisms it contains.  Figure 9 shows vial 2 
after it has been zoomed in this way.  To return the vial to its former size, click in 
the zoom box a second time. 

 
Figure 9.  Vial 2 zoomed so that all progeny are visible. 
 

Summarizing the Vial 

Instead of counting each of the symbols in vial 2 to find the ratio of Tetraltera to 
Grooveless organisms, you can have the computer do the counting for you.   
Select the vial you want to summarize (in this case, vial 2) by clicking once on 
the vial title.  The title will be displayed on a black background when a vial is 
selected.  Then, choose the Summary Chart option from the Analysis menu.   A 
window similar to that shown in Figure 10 will appear. 
 

 
Figure 10.  A vial summary for the Thorax trait 
 
This summary shows the ratio between Tetraltera and Grooveless, two 
variations of the Thorax trait.  If you want to look at the ratio between the sexes 
instead, click in the box to the left of Sex to mark it, click in the box to the left of 
Thorax to unmark it, and click on the Rebuild button to rebuild the summary 
chart to show the ratio between the sexes.  At least one box must always be 
marked, so you cannot remove the mark on Thorax before you mark Sex. 
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Quitting 

This is the end of the tour of Genetics Construction Kit.  If you want to quit at 
this point, you can do so by choosing the Quit item from the File menu.  If you 
have done any crossing, you will be asked if you want to save your work. If you 
decide not to quit after all, click on the Cancel button.  If you save your work, 
the section in the reference section entitled Opening a Saved Problem will tell 
you how to restore the problem to where you left it. 
 
If you want to look at Genetics Construction Kit in more detail, read the 
Reference section.   
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Reference 

Controlling Vials 

 
Figure 11.  The parts of a vial 
 
 

  Selecting a Vial 
 
Before you can perform an operation on the contents of a vial or a series of vials, 
you need to select  it.  Selection is necessary if you want, for example, to destroy 
vials, summarize them, or perform a chi squared test on their population. 
 
Note that a selected vial may or may not be the frontmost or active vial.  There is 
always only one frontmost window, but there may be one or many selected 
vials. 
 
The easiest way to select a vial is to click once on its title.  Clicking a second time 
will unselect the vial.  A selected vial's title is printed on a black background.  
An unselected vial's title is printed on a white background. The vial shown in 
Figure 12 is selected. 
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To select more than one vial, hold down the shift key while clicking on 
subsequent vials.  This is useful when you want to clump the populations of 
several vials together an summarize them, or to do a chi squared test. 

 
Figure 12.  A selected vial 
 

Changing Vial Size and Shape 
 

Closing a Vial 
 
When you have many vials on the screen, it is convenient to reduce some of 
them to miniature form so that you can put them out of the way.  If you move the 
mouse pointer over the close box , in the upper left corner (see Figure 11), and 
click, the vial will shrink down to icon form.  Figure 13 is a picture of a vial in 
icon form.  When you want to re-open a vial in icon form, click twice in quick 
succession on the icon. 
 
Note that it is not necessary for a vial to be open for you to select it.  Select a vial 
in icon form by clicking anywhere on the icon. 

 

Zooming a Vial 
 
If you click in the zoom box,  in the upper right corner (see figure 11), the vial 
will enlarge to display its entire contents.  Clicking in the same place again will 
shrink it back to its former size and position. 
 

Resizing a Vial 

Figure 13. A vial in icon form 

 



 14

 
To change the size or shape of a vial, press the mouse pointer over the grow box , 
in the lower right corner (see Figure 11) and, while holding the mouse button 
down, move the mouse.  Move the mouse down to make the vial taller, and 
move it to the right to make the vial wider.  When you release the mouse button, 
the vial will be redisplayed with the new size and shape. Figure 14 is a picture 
of a vial that has been widened so that all of the traits are visible. 
 

 
Figure 14. A resized vial. 
 

Scrolling Vials 
 
Many vials hold considerably more information than they have room to display.  
The three scroll bars (see Figure 15) allow you to see information that was not 
originally visible.  The organism scroll bar scrolls horizontally through the 
organism symbols, the trait scroll bar scrolls horizontally through the traits, and 
the vertical scroll bar scrolls vertically through the phenotype descriptions and 
associated organism symbols. 
 
Every scroll bar is either active or inactive.  An active scroll bar has a gray 
background, which indicates that there is invisible material.  An inactive scroll 
bar is all white, indicating that all available material is already visible.  In Figure 
15,  both horizontal scroll bars are active and the vertical scroll bar is inactive.  
This means that that there are only two phenotype classes in this vial.  If there 
were more than two, the vertical scroll bar would be active.  Similarly,  there is at 
least one trait other than Wing Shape.  To see what it is, we can click once in the 
trait scroll bar's right arrow.  The result is illustrated in Figure 16. 
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Figure 15.  Both horizontal scroll bars are active, the vertical is inactive. 
 

 
Figure 16.  The trait scroll bar has been scrolled to the right once. 
 
Notice that the white box (the scroll box) in the trait scroll bar now appears in the 
center of the scroll bar.  This indicates that there is additional information both to 
the right and to the left of the Eye Color trait.  There are at least three traits in this 
problem. 
 

Adjusting the Window Pane 
 
Vials are divided into two window panes.  The left hand pane holds the 
organism sex symbols, and the right hand pane holds phenotype descriptions.  
You can change the allocation of space between the two panes by  clicking in the 
black rectangle at the base of the line separating the two panes (the pane control)  
and dragging it to the right or left. 
 
Figure 17 shows the same vial as in Figure 14 but the pane control has been 
dragged to the right so that all the organism symbols are visible.  The mouse 
pointer is over the pane control. 
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Figure 17. A vial with the window pane line moved to the right. 
 

Reorganizing a Vial 
 

Changing Trait Order  
To change the trait display order, click on the name of the trait and drag it to the 
position you want.  I clicked on the word 'Bristles' in Figure 17 and dragged to 
the right to move it off the end, making space for  the Eye Color trait.  The 
resulting vial is shown in Figure 18.  Changing the trait display order in one vial 
also changes it anywhere a list of trait names is displayed. 
 
Changing the trait display order is particularly useful when you want to 
concentrate on one trait and ignore the others.  In this situation, drag the trait of 
interest all the way to the left and resize the vial so that you can see only that 
trait. 
 
Notice that as you drag a trait column, the phenotype descriptions automatically 
scroll so that you can drag a trait to a part of the phenotype description that was 
initially invisible. 
 

 
Figure 18. The Bristles trait has been moved off to the right to make room for Eye Color. 
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Changing Row Order 
 
Just as you can rearrange the horizontal order in which traits are displayed, you 
can rearrange the vertical order of the phenotype classes.  This allows you to 
cluster organisms with interesting phenotypes near the top of the vial. 
 
To drag a vial row, click somewhere over the phenotype description part of the 
row (in this example, over one of the words 'Wavy', 'Ruby', or 'Clot'), and drag 
up or down. 
 
Figure 19 shows the same vial as Figure 18, but with the order of the two 
phenotypes reversed. 
 

 
Figure 19.  The order of the two phenotype classes is reversed. 

 

Reading the Parental Information 
 
Information about the breeding pair that produced a vial is displayed at the 
bottom of the vial.  The initial number is the number of the vial that contains the 
parent.   In figure 19, both parents are from vial 1. 
 
If you click on a parent's symbol, the parent will be highlighted not only where 
you have clicked, but also in its home vial.  This allows you to identify which 
particular individual was used in the cross.  It is also useful when you want to 
do another cross using the same parent, select it here and do the cross.    

 

Opening a Notepad 
 
Clicking on the notepad icon ( , upper left corner of every vial), will open a 
window which can be used for taking notes.  You can type into this notepad, 
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paste pictures from other GCK windows into it, print it, or copy it out into a 
word processor to help when you prepare your lab report.   
 
When you have written into a notepad, the icon changes to indicate that the 
notepad is no longer blank ( ). 
 
For more information about using notepads, see the sections below entitled 
Taking Notes and Communicating With Other Programs. 

 

Destroying a Vial 
 
To destroy a set of vials, select them and then choose Destroy Vials from the 
Utilities menu.  If you destroy a vial, it cannot be recovered. 
 
Since destroying a vial is a somewhat dangerous action, you will be asked to 
confirm if this is really what you want to do.  The original vial (the field 
population) cannot be destroyed. 
 

There are really only two reasons to destroy a vial.  If you have reason to believe 
that you are running out of computer memory,  destroying vials will give you 
more space.  Or you may find that the computer display is becoming too 
cluttered,  and that destroying a few uninteresting vials will make it easier to 
find things. 

Selecting Organisms 

n order to do anything with an organism, such as breed it with another organism, 
you need to select it.  To select an organism, move the mouse pointer over the 
symbol that represents the organism and click the mouse button once.  
Unselected organisms look like this: , , ; selected organisms look like this: 

, , . 
 
To select a second organism, you have to press the shift  key on the keyboard 
while you click on the second organism.  The second organism need not be from 
the same vial as the first. If you click on a third organism while still pressing the 
shift key, the first organism you selected will be unselected. 
 
Organisms that have participated in one or more crosses appear slightly 
dimmed.  In some problems, where an organism is only permitted to mate once, 
these organisms may not participate in a cross. 
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Doing Crosses 

Genetics Construction Kit allows you to perform several kinds of crosses.  Any 
particular problem may only support some subset of the available crosses.  To 
find out what crosses are supported, look at the list under the Cross menu. 
 
Cross Two    This is the most general type of cross, it allows you to choose any 
two individuals and cross them (provided, of course that they are of opposite 
sexes if the organisms are dioecious). 
 
To cross two organisms, select them both (remember to press the shift key while 
selecting the second one), and choose Cross Two   from the Cross menu. 
 
There is a shortcut method of crossing two organisms.  If you shift double click 
on the second organism, the cross will be performed automatically. 
 
Like Cross    A like cross is between parents with the same phenotype.  To 
perform a like cross, select an individual and choose Like from the Cross menu. 
 
If no organism of opposite sex and the same phenotype exists, no cross will be 
performed.  If more than one such organism exists, one will be chosen at 
random. 
 
With monoecious organisms, Like will be replaced by Self and will cross an 
organism with itself. 
 
Back Cross    A back cross is a cross between an organism and its parent of the 
opposite sex.  To perform a back cross, select an organism and choose Back from 
the Cross menu. 
 
Since the parents of organisms in the field population are not known, you cannot 
back cross an individual in vial 1. 
 
 
 
Reciprocal Cross    A reciprocal cross is a cross between parents that have the 
opposite combination of sex and phenotype than the parents that produced the 
offspring in the selected vial.  For example: if a vial has a female parent with 
Rosy eyes and a male parent with Carmine eyes, a reciprocal cross would be one 
between a female with Carmine eyes and a male with Rosy eyes. 
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To perform a reciprocal cross, select a vial and choose Reciprocal from the 
Cross menu. 
 
Parents used for a reciprocal cross will be taken from the same vials as the 
selected vial's parents.  If no such parents exist, the cross will not be performed.  
If there is more than one possible parent, one will be chosen at random from 
those available.  
 
Test Cross   A test cross is usually defined as a cross with a homozygous 
recessive individual.  GCK allows you to choose up to two organisms (one of 
each sex) to be your test organisms.  Once you have chosen test organism(s), you 
can perform test crosses by selecting a single organism and choosing Test from 
the Cross menu. 
 
To choose test organism(s), select the organism(s) and choose Set Test 
Organism(s) from the Cross menu.  If you only set one test organism you will 
only be able to do test crosses with organisms of the opposite sex. 
 
GCK will not check to that the organisms you choose as test organisms are really 
homozygous recessive organisms.  This is your responsibility. 
 
To see the current set of test organisms, select the Show Test Organism(s) option 
from the Cross menu (see Figure 20).  The number in front of the organism 
symbol is the number of the vial containing the test organism.  To identify the 
particular organism, click on the sex symbol and it will be selected everywhere it 
occurs, including in its original vial. 
 

 
Figure 20. The current set of test organisms. 
 

Analyzing and Organizing Your Data 

Abbreviating Names 
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In order to display more information in the same space you may abbreviate the 
names of traits and variations.  To do this, choose Abbreviate Names from the 
Utilities menu.  To reverse the abbreviation, choose Abbreviate Names a second 
time. 
 

Vial Summary Chart 
 
To summarize the contents of a vial or set of vials, select the set of vials you 
want to summarize (remember to hold down the shift key if you want to select 
more than one), and choose Summary Chart from the Analysis menu.  A 
window similar to that shown in Figure 21 will open. 

 
Figure 21.  A vial summary chart for vials 2 and 3. 
 
The control panel to the left of the summary chart controls which traits are 
summarized.  To change the summary, click in the boxes to toggle the traits on 
and off and then click the Rebuild button.  At least one trait be marked at all 
times.  Turn on a trait before turning off the old one if you are looking at only a 
single trait. 
 
The population box on top of the summary chart lists the vials that have been 
clumped together for this summary. 
 
You can change the order of the phenotypes in the summary chart by dragging 
the variation names up or down.  Large summary charts have a grow box and a 
vertical scroll bar so that they can be resized and scrolled. 
 
There are three ways you can copy the information in a summary chart to store it 
in a notepad or to export it to another program.  When a summary chart is the 
frontmost window, the Copy Window, Copy Window Data, and Copy Window 
Graph options on the Edit menu will be active.   
 
Copy Window will put an exact replica of the entire summary window on the 
clipboard. 



 22

 
Copy Window Data will put a textual version of the data on the clipboard that 
can be easily exported to a word processor, spreadsheet, or data analysis 
program.  Figure 22 shows the textual form of the summary chart in Figure 21. 
 
Population: Vial  2, Vial  3  
Phenotype Number  
Aristaless 47  
Aristopedia 27  
Total 74  
Figure 22. The textual form of a vial summary created by Copy Window Data. 
 
Copy Window Graph will put a picture of the summary chart proper on the 
clipboard.  From the clipboard it can be pasted into a notepad, a word 
processing program, or a painting program. 

 
Figure 23.  The picture created by Copy Window Graph from a vial summary. 

 

Chi Squared Analysis 
 
The chi squared worksheet allows you to test how closely an observed ratio 
matches the ratios you expect under a given hypothesis.  A chi squared 
worksheet may be configured to refer to any subset of the possible traits. 
 

 
Figure 24. A Chi Squared Worksheet.  The hypothesis tested predicts a ratio of 2:1 for Aristaless 
and Aristopedia.  The p value is .5650. 
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The control panel is the lefthand part of the chi squared worksheet.  It consists of 
a check box for every trait in the problem, a check box for sex, if appropriate, and 
Rebuild and Calculate buttons.  You select the subset of traits you want in the 
chi squared worksheet by clicking in the check boxes and click on the Rebuild 
button to redraw the worksheet.  Click on the Calculate button when you have 
changed the expected ratio to recalculate the chi squared values.  Pressing the 
Return key is equivalent to clicking on the Calculate button. 
 
You cannot specify an empty chi squared worksheet (one with no traits).  If you 
try to uncheck the last checked trait, nothing will happen. 
 
If you believe that one or more classes of phenotype are missing, enter the 
component of the ratio represented by them in the row marked Other. The Other 
row is not used unless the expected ratio is non-zero. 
 
Any category can be removed from the analysis by setting its expected ratio to 
zero. 
 
The p value (lower righthand corner) is the probability of obtaining the observed 
ratio if the expected ratio is the true ratio.  By convention, if it is less than 0.05 
you may safely reject the hypothesis that predicted the expected ratio. 
 
If there are more than four rows of phenotypes, there will be a scroll bar and a 
grow box so that you can make the chi squared analysis window smaller and 
still access all the phenotypes. 
 
You can reorder  the phenotype rows by dragging the phenotype names up and 
down. 
 
The names of traits and phenotypes can be abbreviated by choosing the 
Abbreviate Names option from the Utilities menu. 
 

Under some circumstances, a caution symbol, ,  may appear on your chi 
squared worksheet.  If this occurs, click on it for a warning message about the 
statistical validity of the particular test you have made. 
 
To perform a test: 
 
  • Select the vial or vials that contain the population of interest. 
 
  • Choose Chi Squared Test from the Analysis menu. 
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  • Click in the check boxes to set the traits you need. 
 
  • Click the Rebuild button to set up these traits. 
 
  • Enter the phenotype ratios you expect in the first column. 
 
  • Press Return,  or click on the Calculate button to recalculate. 
 
 

The Cross Matrix 
 
The cross matrix is a record of the crosses you have made so far; it is also an 
index of the vials generated by these crosses.  As a record, you can use it to think 
about the kinds of crosses you have made and the kinds of crosses that you need 
to make in the future.  As an index, it is a useful way to find that pesky little vial 
you shrank to an icon a while ago but can't find anymore. 
 

A Record of Crosses 
 
To open the cross matrix, choose Cross Matrix from the Data Analysis menu.  
You don't need to select anything first (there is only one cross matrix).  Figure 25 
is a cross matrix from a problem with two traits. 
 

 
Figure 25  A cross matrix for a two-trait problem.  It is set up to look only at the Eye Color trait. 
 
The cross matrix in figure 25 tells us that  we have crossed a Ruby male and a 
female Garnet and that vial 3 contains the result of this cross. Similarly, vial 4 
contains a Purple x Garnet cross and vial 2 contains a Purple x Ruby cross.  The 
blank positions in the matrix make clear which crosses have not been made. 
 

An Index into Vials 
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To retrieve a vial shown in a cross matrix, double click on the vial number.  The 
vial will be enlarged if it is in icon form, brought to the front  and selected. 
 
The vial shown in the cross matrix is the vial produced by the latest cross of the 
indicated phenotypes.  If you hold down the option key while double clicking 
on a cross matrix cell, all vials produced by the corresponding cross will be 
brought forward and selected. 
 

Taking Notes 

Using Notepads 
 
Every vial has an associated notepad;  to open it, click on the notepad icon (  or 

) in the upper right corner.   The notepad stays in existence as long as you do 
not destroy its associated vial.  You can close it temporarily by clicking in its 
close box, and when you re-open it, any notes you typed will still be there. 
 
A blank notepad icon indicates that the corresponding notepad is currently 
empty. 
 
Use the notepad just as you would any other Macintosh word processor.  You 
can type into it, paste pictures into it, select parts of it to cut or copy into the 
clipboard, and print it. 
 
If you are not familiar with standard Macintosh word processing methods you 
should consult your Macintosh Owner's Guide for a description. 
 

Printing Notepads 
 
To print a notepad, make sure that it is the frontmost window (clicking 
somewhere in the window will make it frontmost).  The frontmost window is the 
only window which has a set of parallel horizontal lines around its title.  Then 
choose Print Notepad from the Edit menu. 
 
For more information on notepad use, see the section on Communicating With 
Other Programs. 
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Cleaning Up the Benchtop 

After you have been working for a while, your lab bench (the computer screen) is 
likely to get quite messy.  The Clean Up option on the Utilities menu will 
straighten things up by putting things in their original places and closing certain 
windows. 

 

Changing the Cleanup Process 
 
The standard Clean Up process places vials and other windows on your screen 
in a way appropriate for the standard Macintosh 9-inch screen.  If you have a 
larger screen or if you do not like the way clean up works, you can change it.  To 
do this, choose the Clean Up Options option on the Utilities menu.  The window 
shown in Figure 26 will open. 
 
The check boxes at the bottom of the window allow you to specify which 
windows should be automatically closed or (for vials) collapsed to icon form 
during a clean up operation. 
 
The box in the upper part of the window shows where each of the different kinds 
of windows created by GCK will be placed when it is first created and when you 
ask for a clean up.  In Figure 26, the six black rectangles represent the placement 
of the first six vials (later vials will be placed on top of the first six, offset a little).  
You can change the number of rows and columns of vials, and the spacing 
between them, by adjusting the large rectangle with the little grow box in the 
lower right corner.  You can change the placement of the group of all vials by 
dragging the big rectangle around the screen. 
 
To change the placement of other kinds of windows, click on the Next button to 
bring the next set of windows to the top, or click directly on the gray boxes 
representing the window you want to change. 
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Figure 26.  The Clean Up Options window. 
 

Communicating With Other Programs 

All communication between GCK and other programs takes place via the 
Macintosh Clipboard.  Think of the clipboard as a place you can temporarily 
store a piece of text or a picture from one program, and then retrieve it from 
another program.  You proceed by Copying material from one program into the 
clipboard, switching to the other program, and then Pasting  the clipboard into 
the second program. 
 
This can be quite clumsy if you need to move several different things between 
the same two programs, since the clipboard can only hold one thing at a time.  In 
this situation you may want to look into using the Macintosh Scrapbook (see 
your Macintosh Owner's Guide) which can hold more than one thing at a time. 
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Cut, Copy, Paste, and Clear 
 
You can use Cut, Copy, and Paste to move text and pictures between GCK 
notepads and other programs.  Unfortunately, however, it is not possible to copy 
and paste mixed text and pictures at one time.  
 
 To copy a notepad that contains both text and pictures you need to do the 
following: 
 

• Select the entire content of the notepad.  You can do this by clicking 
before the first word and dragging to the end, or by clicking once 
before the first word, scrolling to the end, and shift-clicking after 
the last character. 

 
• Choose Copy from the Edit menu. 
 
• Paste the result into an external word processor.  Where pictures 

exist in the original notepad you will see a little box ( ). 
 
• For each picture in the notepad: 

• Select the picture.  It is critical that you select only the 
picture and no surrounding blank space.  

• Choose Copy to put a copy of the picture on the clipboard. 
• Paste the picture into your word processor. 

 

Copy Window 
 
The Copy Window option on the Edit menu is active as long as there is at least 
one window open.  It will put a picture of the current frontmost window on the 
clipboard.  Once it is on the clipboard it can be pasted into a notepad or into 
another Macintosh program. 
 
The picture of the window looks exactly like the window.  This is potentially 
confusing because it is not a window any more, but just a picture of one.  This 
means that the close box and other controls will not work. 
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Copy Window Data 
 
The Copy Window Data  option on the Edit menu will put a copy of the data  a 
window contains on the clipboard in a form that is usable (not only displayable) 
by other programs.  The data is in tab delimited text  format that is usable by 
many word processors, spreadsheets, data base managers, and graphing 
programs. 
 
Tab delimited text is text arranged in columns with each column separated by a 
tab.  If you paste this into a word processor you will need to set the tab stops to 
line up the columns. 
 
Vials, Summary Charts,  and Chi Square Worksheets are the GCK windows that 
export their data in this way.  The data stored in the frontmost window will be 
exported. 
 

Copy Window Graph 
 
The Copy Window Graph option on the Edit menu will put a copy of the graph in 
a Summary chart on the clipboard.  This option is only available if the frontmost 
window is a Summary Chart window. 
 

Printing a Window 
 
You can always print the frontmost window, if you have a printer attached to 
your computer, by holding down three keys simultaneously.  The three keys are 
the shift key, the command key( ), and the "4" key.   If you also press the caps 
lock key, the entire computer screen will be printed.  These procedures are not 
only part of GCK , but are characteristic of every Macintosh program. 
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Getting Help 

There are several ways to ask for help from GCK or any other BioQUEST 
program. 
 

Why Can't I Use This Menu Item? 
 
At any one time several menu items will be gray, indicating that they are 
inactive and therefore cannot be used.  Active menu items appear in black.  It is 
not always obvious why a menu item is inactive, or how to make it active.  In 
GCK, if you try to choose an inactive menu item, you will get a short message 
explaining what to do in order to enable it (see Figure 27).  Usually this means 
selecting an object. 
 

 
Figure 27. A Help message explaining why the Vial Summary item is inactive. 
 
Use the scroll bar on the right to see text that is not immediately visible.  When 
you have finished reading the help message, you can dismiss it by clicking in 
the window close box. 
 

What Is This Thing For? 
 
To find out what something is or does, you need to be in help mode.    To enter 
help mode, press the command key ( ) while simultaneously pressing the 
question mark (?) key.  On some keyboards there is a key labeled help.  If your 
keyboard has a help key, it will do the same thing. 
 

When you are in help mode, the mouse cursor will look like this , instead of 
the usual arrow shape.  In help mode, all menu items are always active.  
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Selecting a menu item will give you a short description of what the menu item 
does (see Figure 28). 

 
Figure 28. An Explanation of the Vial:Summarize menu item 
 
Besides menus,  you can click on just about anything and get some information 
about it.   
 
Usually, you automatically drop out of help mode after you get help once.  
Sometimes you want to ask for help on several things and it is useful to stay in 
help mode.  If you hold down the option key while clicking, you will stay in 
help mode. 
 

What About the Big Picture? 
 
The general help system is accessible from the Help With GCK  option under the 
Apple (�) menu.  If you choose this option you will be given a list of topics from 
which to choose the subject of interest (see figure 29).  To open a topic, click on it 
and click the Open  button at the bottom of the help window, or double click on 
the topic line.  When you open a topic you will either see a list of sub-topics or a 
discussion of the subject. 
 
At the bottom there will often be a Back  button.  Pressing it will return you to 
the topic list that led you to the current window.  Sometimes there will be other 
buttons that should be labeled so as to be self explanatory. 
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Figure 29.  The Help with GCK  topic list.  Clicking Open will lead to information about Quick 
Tutorials. 
 

Saving and Opening a Problem 

Saving a Problem 
 
You can save the state of the problem you are working on at any point by 
choosing the Save option from the File menu.  This saves everything so that you 
can later come back to the problem in the same state it was in when you left it. 
 
There are a number of reasons you may want to save a problem.  The simplest is 
that you may want to take a break and come back to a problem later.  Another 
reason is to keep all of your original research data.  If someone then challenges 
your conclusions, you can go back to the original organisms with new questions.  
Or you may want to save a copy of a problem before you do any work at all so 
that another research team can work on exactly the same problem and you can 
pool, and argue over, your results. 
 
You may also want to save against the possibility of catastrophe in the form of as 
power failure or an problem with the program that causes it to stop working 
suddenly. 
 
When you choose Save the first time, you will be asked to give the problem a 
name (see Figure 30).  If the process of giving a file a name is unfamiliar to you, 
please refer to BioQUEST: Macintosh Basics. 
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Figure 30. A Save Problem dialog box.  By default, the problem will be saved under the name 
'Untitled0'. 
 
When you are ready, click the Save button to save the problem, or click the 
Cancel button if you decide not to save. 
 
The second time you choose Save, your problem will automatically be re-saved 
under the same name you used the first time. 
 
If you want two different copies, use the Save As option instead of Save.  This 
will ask you for another name. 
 
 

Opening a Saved Problem 
 
There are two ways to open a previously saved problem.  The simplest way is to 
double click on the saved problem's icon from the Finder (see Figure 31). 

 
Figure 31. A saved problem icon. 
 
Alternatively, if you are already running GCK, you can choose Open from the 
File menu and choose your problem from the list presented there. 
 
Note that you can only have one problem open at a time.  If you try to open a 
second problem, you will first be asked if you want to save the current problem. 
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